
EFFECTIVE DECISION MAKING USING MINDGENIUS

What is Decision-Making?
We always seem to be faced with making decisions, no matter which way we turn.

Some decisions can be hurried, whereas others require careful deliberation. Some can be based on logical deduction,
whereas others are based on instinct or gut feel. Often, decisions are a mixture of both. 

Decision-Making is an essential part of daily life.  As individuals, teams and organisations, we are constantly challenged
to make and take the right decisions. Good Decision-Making sets direction, objectives and targets, and results in actions
aligned to achieve desired progress.  

Good Decision-Making provides leadership and inspiration.

Traditional Approach
Traditionally, Decision-Making is often based on hunches and gut feel, due to the poor quality of information on which the
decision would be based.   When decisions are made based on information provided, the former are usually poor, due to
insufficient confidence in the latter.
The key to good Decision-Making is good, well-thought out information which considers all viewpoints, takes account of
risks, and justifies assumptions.
However, currently flipcharts or whiteboards are used by many as the main method of compiling and analysing the
information on which decisions are based.   Manually, this typically runs into many pages, all of which need to be pored
over in detail to be properly interpreted and understood.  This is an extremely arduous task that can take weeks to
conclude. As a result, many Decision-Making processes fail to achieve their objectives. 
Unfortunately it is all too common for an excellent in-depth thinking session prior to Decision-Making to become bogged
down, resulting poor or no decisions. 
This problem, as we will show, is overcome totally with MindGenius. 

Decision-Making with MindGenius
Decision-Making with MindGenius is simple and straightforward. It requires a meeting room with computer projection
capability and a PC with MindGenius installed.
The Decision-Making session requires a facilitator to ensure that all areas are covered equally and ideally a scribe to type
the thinking directly into MindGenius.
If a scribe is not available, the facilitator would typically log the thinking.  Typical questions used by a facilitator are
available the Decision-Making sample map directly from the help menu.
Logging the thinking required to make good decisions is simple, as can be seen from the instructions below:



You are more likely to make a good decision if you carefully consider your options and the ramifications they have on
yourself and others. It helps if you follow a specific process to ensure that you take a well-rounded view and make your
decision based on the best information available to you within the timeframe that you have to make the decision. 

Such a process is as follows:
1. Question - Identify what exactly is the decision that has to be made, what it is seeking to achieve and why it
is needed.
2. Explore - Check out your alternatives. What are your options/alternatives, risks, assumptions, success 
factors?
3. Rank - Understand the pros and cons of pursuing these alternatives. Prioritise the alternatives based on how
they achieve the intended objectives of the decision required. Which alternative(s) best achieve(s) the desired 
result.
4. Decide - Are you happy with the best ranked option(s)? How do they fit with the success criteria, risks, 
assumptions previously identified? Decide which one to go with.
5.Communicate - Communicate the decision to the appropriate people.

To let you see how MindGenius can help you with the decision making process, let's use the following scenario.

You are becoming disenchanted with your current job. You have been doing the same job for the past two years. You are
repeatedly doing the same things over and over again. There is a lack of new challenges in the work you do, so you are
becoming bored. You have taken on other tasks to attempt to alleviate your boredom but you don't feel that you are getting
any reward or recognition for this. The outlook for promotion is limited. Your immediate manager has been in his current
position for ten years and does not appear to have any ambition or prospect of progressing up the promotion ladder. In
fact you believe that he is under performing in his current role and your suggestions on ways of introducing performance
improvements have fallen on deaf ears. So much so that you are now starting to have arguments with your manager and
a fellow worker who wish to stay in their comfort zone and maintain the status quo. So what are you going to do? Have
you a decision to make?

Now let's go through the decision making process using MindGenius

Step 1 - Question
All too often people make decisions without truly understanding whether or not the decision was really required or why it
was needed. To make a good decision you need to understand the background to the decision and what it is seeking to
achieve. You need to have answers to questions such as:

WHO? • Who needs the decision?
• Who has to make the decision?
• Who is affected by the decision?

WHAT? • What is the 'problem' you are seeking to overcome?
• What is the desired end result?
• What alternatives are there?
• What would happen if no decision was taken?

WHEN? • When does the decision have to be made by?
• When does the outcome of the decision need to be implemented by?

WHERE? • Where has the decision to be made
• Where has the decision to be announced?

WHY? • Why is the decision required?

HOW? • How is the decision to be communicated?
• How will the decision be reached?
• How will the decision be deployed?



MindGenius provides you with a Decision-Making template to help you question whether or not you need to make a
decision. Select 'New...' from the File menu to launch the templates dialog. Select the 'Techniques' tab and double-click
'Decision Making' template the following map will appear.

When the template opens you will be prompted to enter a brief description of the subject matter you need to make a
decision on.

In this case, you would type in "Decision required on job situation" which would overwrite the text 'Decision'. Clicking OK -
or pressing the Return key - results in the root branch of the map being set to 'Decision required on job situation'.

You can now use the template questions as a prompt for your thoughts.

Tip: If you wish to insert a line break (carriage return) in the Branch text, open the Edit Branch dialog box, select the point that you wish to insert a line break

and press {Ctrl}+{Enter}



MindGenius incorporates a special branch text entry method to minimise any intrusion into your thought process. Click
on any branch. You have now selected the branch (parent) you wish to add a sub-branch (child) to. Type in the child
branch title - the 'Add Branch' dialog will automatically appear in response to your keyed input. Pressing the Return key
will add the branch.

You can continue to 'type-and-return' and more child branches will be added to the parent branch, or select a different
parent branch to add child branches to. 

The first step is to understand the need for a decision to ensure that unnecessary decisions are not taken. So you click
on a branch and start recording your thoughts using the 'type and enter' method. 

In some cases you will need to brainstorm some ideas.  For example you don't need to make a decision if you do not
have at least 2 alternatives to choose from. So if you click on the 'alternatives' branch then you can add some potential
approaches. Your map could develop as shown below:



Your map will rapidly grow:



There may be areas within the workmap that you might wish to add more detail to remove any ambiguity or doubt on the
meaning of a branch when you revisit it at a later date. You can add this detail, whilst preserving the visual summary of
your map by inserting text as a note to a branch within your map.

To Do this:
1. Select the branch you wish to add a note to.
2. Click on the Notes Pane icon and the Notes Editor Tile will appear. You can now enter a text description. The
Note will be attached to the branch but the visual summary of the branch will be preserved - only the Notes 
symbol will appear on the branch.  

You can use this technique on any branch within your map.

From the above map it is evident that you need to make a decision. The situation will get worse if you do nothing and you
are already being adversely affected. There are alternative approaches that you could pursue. 

You are clearer in your own mind why you need to make the decision and what you are seeking to achieve. So you would
proceed to the next step in the process.



Step 2 - Explore
Having confirmed that a decision is required, you need to start exploring your options/alternatives, risks, assumptions,
and success factors in order to gather and understand the information that you will need to base your decision on.

First, let's explore your alternatives further.

Your map has already grown in size and complexity. MindGenius has a Map Explorer feature that gives you powerful
navigation capabilities and allows you to 'walkthrough' your map and to focus in on specific areas. 

When you click on a branch in the Map Explorer, MindGenius automatically redraws the map to show the selected branch
as the root branch with its child branches and structures displayed. 



You can now explore your alternatives. Let's say you identify that there are some additional options:

• You could learn new skills and
move into another discipline or type
of work
• You could become your own boss
and start your own business

Simply type and enter to add these
options. The MindGenius workmap
will simply flex and grow to
accommodate them.

The sequence of the branches might not be correct. MindGenius lets your quickly re-arrange your thoughts by drag-and-
drop within your map. For example, your 'Alternatives' could be rearranged as follows:

So using Map Explorer, type and enter and drag and drop you can flesh your 'Alternatives' out. You can also add new
branches for 'Success Factors', 'Risks', and 'Assumptions'. This could result in the follow



Alternatives

Success Factors



Risks

Assumptions

You've explored the options, considered the risks, clarified your assumptions and identified key success factors that need
to be met.

So now you are ready to move to the next step in the process.



Step 3 - Rank
Not all of your options have an equal chance/probability of realising your desired outcome. You need to rank them based
on specific criteria. What is the likelihood that you will be able to successfully complete a specific option? What is the
likelihood that a given option will realise the benefits that you desire?

A simple way is to classify them in one if the following boxes:

MindGenius provides you with the capability of assigning key words (categories) to branches. You can use them to visually
indicate the likelihood of success and the likelihood of achieving the desired benefits.

Using the MindGenius categories you can assign the appropriate key word to a branch. In the case of the above matrix
we will use the following category symbols:

You can add additional branches to indicate potential reasons for your rankings (or add explanations in the branch Notes:

High Medium Low
Likelihood of success
Likelihood of desired benefit

High Medium Low

Likelihood of success

Likelihood of desired benefit



MindGenius provides you with the capability of filtering your map.

You are interested in alternatives that have a high likelihood of success AND a high likelihood of achieving the desired
benefits. To show this information, use the Filter Tile to filter on these two categories:



Note that this results in a filtered map view of your alternatives as follows:

There is only one alternative that matches these criteria, the option of transferring to another job within the company and
specifically to a new division opening abroad.

The next likely option would be to seek a job with another company (M, 2), as all the other options included at least one
of the lowest likelihoods (L or 1)

So having ranked the alternatives you can proceed to the next step in the process



Step 4 - Decide
Although there seems only to be one real option, it is still worthwhile checking that it meets your original criteria and that
you would be comfortable proceeding with that option.

So how does it stack up? Create a new level 1 branch in your map titled 'Preferred options' Add a child branch titled
'Transfer to new division opening abroad'.

Copy the 'Success Factors', 'Risks' and 'Assumptions' branches as children of the 'Transfer….' branch. To do this:
1. Select 'Success Factors'
2. Hold down the Ctrl key and select 'Risks' and 'Assumptions' too, all three  branches should now be shown as
selected
3. From the Edit menu, choose 'Copy' (or use the shortcut keys Ctrl + C)
4. Select the new branch you added 'Transfer to new division opening abroad'
5. From the Edit menu, choose 'Paste' (or use the shortcut key Ctrl + V)

Group edit all of these branches to have rounded box shapes in order to visually differentiate between the original
branches and your analysis against them. To do this:

1. Select 'Transfer to new division opening abroad' by holding down the Shift key when you click on the branch
with the mouse. This will select this branch AND all it's children
2. From the Branch Menu, select 'Branch Appearance…' (or press F3)
3. On the 'Branch Shape' tab, set the Shape Style to 'Round Box'

This section of the map will now look like the following: 

Now you can use Map Explorer to focus on each viewpoint  in relation to your preferred option.



This could result in the following. (Note that your comments/analysis is differentiated by not being enclosed in a rounded
box shape)

The overall picture appears to be very favourable so you would probably decide that the preferred approach is the one
that you would like to go with. Your decision is made and you can move on to the next step in the process.



Step 5 - Communicate
Going back to the 'Who?' part of your map, you will see that although you have made your decision, it still needs to be
discussed and agreed with your spouse. You can walk your spouse through your map to explain how you arrived at your
decision and hopefully convince them to support your decision. If your spouse raises any points, you can add them to the
map and explore them together. Assuming such changes do not have any significant impact you will both be in agreement,
the decision is made and you can proceed to formulate a plan to implement your decision.

Some of the extras you get?
Workmap structure and hierarchy
As you record information on the decision making framework provided by the template the sequence and hierarchy of
branches you generate in relation to their parent branch are automatically created and numbered as you add the
branches. The numbering system associated with this sequence/hierarchy can be made visible to aid understanding.

Mental Connections
There will be times when you see a connection between two branches that cut across the structure and hierarchy of your
workmap. They are likely to lie in two entirely different avenues of thought. It is from such linkages that breakthrough
thinking and novel, innovative ideas originate. You can mark this link using the Mental Connection feature within
MindGenius and then generate a new workmap to flesh out this new avenue of thought.

Attachments
Any number of electronic files or hyperlinks can be assigned to a branch. These can be opened from within the workmap
and you have instant access to a host of supporting information and research. This is particularly useful if there is data
available in electronic format to support any research you have carried out in support of your decision.

Different views
Normally the decision making process is carried out using the MindGenius 'Map' diagram. There may be occasions when
this is not the best way to present the material, to make best use of screen space and to 'see' linkages/connections
between branches that cut across the hierarchical structure. At the click of a mouse you can transpose your workmap into
the following diagram types with specific usages:

• Output Tree ((for identifying solution and effect relationships)
• Outline (list view)
• Input Tree (for identifying cause and effect relationships)
• Affinity diagram (for grouping)
• Organogram (for hierarchical structures)



Resources
As well as categories, you can also assign resources to specific branches. Helps you identify who does what. There may
be particular activities you want a specific individual to perform and you can use the resource feature within MindGenius
to visually indicate this.

Actions
When used in conjunction with resources you can designate a branch as an action and assign it to a particular resource
(individual). You can then send the action request to the specified person via MS Outlook.

Creating new maps
MindGenius will automatically create a new workmap based on groupings of the category or resource codes that you
assign to the branches. View your workmap from a completely different perspective.

Customising your decision making approach
As you continue to use workmaps for decision making you are likely to identify specific areas that you should consider
that may be personal to either yourself, your work activities or your organisation. Simply edit the template to add/edit or
delete branches as required. You can also personalise the 'look' of the template to give it a more corporate or organisation
specific look (colour, map background etc).

Sharing the thought processes on which your decision has been made.
You can share the reasoning behind your decision with other people to communicate it to them, or to solicit their opinion,
comments and feedback in a number of ways:

• In face-to-face situations you can walkthrough your maps during a review session using the Map Explorer 
navigation features within MindGenius You can use full screen mode {View}, {Full Screen} to maximise the 
screen area used for the map.
• You can run MindGenius on web conferencing applications such as WebEx to communicate your maps to 
people in different geographical locations.
• Send them the workmap via e-mail from within MindGenius
• Package up the files into a single file and send it as a file attachment
• Send them the MindGenius files along with a viewer so that they can view the files even though may not have
MindGenius on their PC
• Save the maps as HTML files and people can access them and view them over the internet/intranet.



SUMMARY
MindGenius allows you to gather and understand the right information, and think through the Decision-Making process.  

With MindGenius, decisions are thought through in a highly effective and practical way, and the operational difficulties
associated with the traditional way of managing and understanding the data generated become a thing of the past.

Finally, by using MindGenius, the correct decisions are made, and decisions which are well-thought out and supported by
the right information become the norm in an organisation.

Whenever we make a hurried decision, in any area of life, we are often asked by those close to us if we have really
thought things through.

The process for really thinking through your decisions before you make them follows a common framework when working
with MindGenius, as detailed below:

1. Information is GATHERED from a range of sources and people

2. This information goes through a process of being analysed and UNDERSTOOD before decisions are taken 
as what it means and how we progress forward

3. Our findings and recommendations from the Understand phase is BOUNCED off any colleagues who could 
conceivably add value to by tapping into their collective knowledge, experience and creativity and in doing so 
avoiding any difficulties encountered previously

4. Finally, with everyone in agreement on what needs to be done an action plan is produced to DELIVER the 
necessary components to ensure objectives are met

Sample maps explaining the gather, undertand, bounce and deliver  phases are available directly from the Help menu.
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